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Chapter 1  Overview 

1.1 Description 

HVS PC Client is a versatile video management software for the DVRs, NVRs, IP cameras, encoders, 

decoders, VCA device, alarm host, etc. It provides multiple functionalities, including real-time live view, 

video recording, remote search and playback, file backup, alarm receiving, etc., for the connected 

devices to meet the needs of monitoring task. With the flexible distributed structure and easy-to-use 

operations, the client software is widely applied to the surveillance projects of medium or small scale. 

This user manual describes the function, configuration and operation steps of the PC Client software. 

To ensure the properness of usage and stability of the software, please refer to the contents below 

and read the manual carefully before installation and operation. 

1.2 Running Environment 

Operating System: Microsoft Windows 7 / Windows 2008 (32 / 64-bit), Windows 2003 / Windows XP 

(32-bit) 

CPU: Intel Pentium IV 3.0 GHz or above 

Memory: 1G or above 

Display: 1024*768 or above 

Notes： 

 For high stability and good performance, these above system requirements must be met.  

 The software does not support 64-bit operating system; the above mentioned 64-bit operating 

system refers to the system which supports 32-bit applications as well. 
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1.3 Function Modules 

Control Panel of PC Client: 

 

Click on the Home icon on the top left corner to bring on the Menu Bar. 

Menu Bar: 

File 

Open Captured picture Search and view the captured pictures stored on local PC.  

Open Video File Search and view the video files recorded on local PC. 

Open Log File View the backup log files. 

Exit Exit the PC Client software. 

System 

Lock Lock screen operations. Log into the client again to unlock. 

Switch User Switch the login user. 

Import System Config File Import client configuration file from your computer. 

Export System Config File Export client configuration file to your computer. 

View 

1024*768 Display the window at size of 1024*768 pixels. 

1280*1024 Display the window at size of 1280*1024 pixels. 

1440*900 Display the window at size of 1440*900 pixels. 

1680*1050 Display the window at size of 1680*1050 pixels. 

Full Screen Display the window in full screen. 

Control Panel Enter Control Panel interface. 

Main View Open Main View page. 

Remote Playback Open Remote Playback page. 

E-map Open E-map page. 

Auxiliary Screen Preview Open Auxiliary Screen Preview window. 

Tool 

Device Management Open the Device Management page. 

Event Management Open the Event Management page. 

Record Schedule Open the Record Schedule page. 

Account Management Open the Account Management page. 

Log Search Open the Log Search page. 
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System Configuration Open the System Configuration page. 

Broadcast Select camera to start broadcasting. 

Device Arming Control Set the arming status of devices. 

I/O Control Turn on/off the alarm output. 

Player Open the player to play the video files. 

Message Queue Display the information of Email message to be sent. 

Help 

Open Wizard Open the guide for the client configuration. 

Open Video Wall Wizard Open the guide for the video wall configuration. 

User Manual (F1) 
Click to open the User Manual; you can also open the User 

Manual by pressing F1 on your keyboard. 

About View the basic information of the client software. 

Language 
Select the language for the client software and reboot the 

software to activate the settings. 

 

The HVS PC Client software is composed of the following function modules: 

 

The Main View module provides live view of network cameras and video encoders, and 

supports some basic operations, such as picture capturing, recording, PTZ control, etc. 

 
The Remote Playback module provides the search, playback, export of record files. 

 

The E-map module provides the displaying and management of E-maps, alarm inputs, hot 

regions and hot spots. 

 

The Device Management module provides the adding, modifying and deleting of different 

devices and the devices can be imported into groups for management. 

 

The Event Management module provides the settings of arming schedule, alarm linkage 

actions and other parameters for different events. 

 
The Record Schedule module provides the schedule settings for recording. 

 

The Account Management module provides the adding, modifying and deleting of user 

accounts and different permissions can be assigned for different users. 

 

The Log Search module provides the query of system log files and the log files can be 

filtered by different types. 

 

The System Configuration module provides the configuration of general parameters, file 

saving paths, alarm sounds and other system settings. 

 
 

The function modules are easily accessed by clicking the navigation buttons on the control panel or by 

selecting the function module from the View or Tool menu. 

 

You can check the information, including current user, network usage, CPU usage, memory usage and 

time, in the upper-right corner of the main page. 
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1.4 Updates Instruction  

Multiple newly-designed functions are offered in the latest HVS PC Client software. You can get a brief 

view of the updates instruction from the following contents. 

 Support Management for Multiple New Device Types 

Some new device types can be added and managed by the client, including the fisheye camera, 

device registered on Hills Auto-Config service, VCA device, transcoder, video wall controller. 

 Support VCA Playback 

VCA rule can be set to the searched record files and find the video that VCA event occurs, 

including VCA Search, Intrusion and Line Crossing. This function helps to search out the video 

that you may be more concerned, and the playback speed of the concerned video and 

unconcerned video can be customized. 

 Newly Added Event Configuration 

The event, such as audio detection, defocus detection, face detection and line crossing detection, 

can be configured via the client. And alarm linkage settings for the events are also configurable. 

 Alarm and Event Information Filter 

The received alarm and event information can be filtered by selecting the needed event types. In 

this way, the important information can be searched quickly. 
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Chapter 2  Live View 

2.1 User Registration and Login 

 

When opening HVS PC Client after registration, you can log into the client software with the registered 

user name and password. 

Steps: 

1. Input the user name and password you registered. Default user name is ‘admin’, default password 

is ‘admin1234’. 

2. Optionally, check the checkbox Enable Auto-login to log into the software automatically. 

3. Click Login. 

 

 

After running the client software, a wizard will pop up to guide you to add the device and do some 

basic settings. 

2.2 Adding the Device 

Purpose: 

After running the PC Client, devices including network cameras, video encoders, DVRs, NVRs, decoder, 

etc. should be added to the client for the remote configuration and management, such as live view, 

playback, alarm settings, etc.  

Perform the following steps to enter the Device Adding interface: 

1. Click the  icon on the control panel, 

or click Tools->Device Management to open the Device Management page. 

2. Click the Server tab. 

3. Click Encoding Device to enter Encoding Device Adding interface. 

Note: Here we take the adding of NVR as an example. 
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You can add the device in the following ways: 

 By detecting the online devices, see Section 2.2.1 Adding Online Devices. 

 By specifying the device IP address, see Section 2.2.2 Adding Devices Manually. 

 By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment. 

2.2.1 Adding Online Devices 

Purpose: 

The active online devices in the same local subnet with the client software will be displayed on a list. 

You can click the Refresh Every 15s button to refresh the information of the online devices. 

Steps:  

1. Select the devices to be added from the list. 

2. Click Add to Client to open the device adding dialog box. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address. The IP address of the device is obtained automatically in 

this adding mode. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

5. Click Add to add the device. 
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Add All the Online Devices 

If you want to add all the online devices to the client software, click Add All and click OK in the pop-up 

message box. Then enter the user name and password for the devices to be added. 

 

Modify Network Parameters 

Select the device from the list, click Modify Netinfo, and then you can modify the network 

information of the selected device. 

Note: You should enter the admin password the device in the Password field of the pop-up window to 

modify the parameters. 

Restore Default Password 

Select the device from the list, click Restore Default Password, input the security code, and then you 

can restore the default password of the selected device. 

Note: The default admin password of the device is 12345, and the security code is returned after you 

send the data and serial No. of the device to the manufacturer. 

2.2.2 Adding Devices Manually 

Steps: 

1. Click Add Device to open the device adding dialog box. 
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2. Select IP/Domain as the adding mode. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address or domain name. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

5. Click Add to add the device. 

 

 

2.2.3 Adding Devices by IP Segment 

Steps: 

1. Click Add Device to open the device adding dialog box. 

2. Select IP Segment as the adding mode. 

3. Input the required information.  

Start IP: Input a start IP address. 

End IP: Input an end IP address in the same network segment with the start IP. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the 

channels of the device will be imported to the corresponding group by default. 

5. Click Add, and the device of which the IP address is between the start IP and end IP will be added 

to the device list. 
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2.3 Group Management 

Purpose: 

The devices added can be organized into groups for a convenient management. You can get the live 

view, play back the record files, and do some other operations of the device through the group. 

Before you start: 

Devices need to be added to the client software for group management. 

 

Perform the following steps to enter the Group Management interface: 

1. Open the Device Management page. 

2. Click the Group tab to enter the Group Management interface. 

 
 

Adding the Group 

Steps:  
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1. Click  to open the Add Group dialog box. 

2. Input a group name as you want. 

3. Click OK to add the new group to the group list. 

You can also check the checkbox Create Group by Device Name to create the new group by the 

name of the selected device. 

 

 

Importing Encoding Device to Group 

Steps: 

1. Click Import on Group Management interface, and then click the Encoding Channel tab to open 

the Import Encoding Channel page. 

2. Select the thumbnails/names of the cameras in the thumbnail/list view. 

3. Select a group from the group list. 

4. Click Import to import the selected cameras to the group. 

You can also click Import All to import all the cameras to a selected group. 

Notes:  

 You can also click the icon  on the Import Encoding Channel page to add a new group. 

 Up to 64 cameras can be added to one group. 

 

The following buttons are available on the Import Encoding Channel page: 

 List View View the encoding camera in list view. 

 Thumbnail View View the encoding camera in thumbnail view. 

 Refresh Refresh the latest information of added cameras. 

 Import Create a group named as device name-Encoding Channel 
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(Alarm Input) and import the device to group. 

  Collapse/Expand Collapse/Expand the thumbnails of cameras. 

 

Modifying the Group/Channel 

Steps: 

1. Select the group/camera from the group list on the Import Encoding Channel page. 

2. Click , or double-click the group/camera name to open Modify Group/Camera dialog box. 

3. Edit the group/camera information, including the group/camera name, the stream type, etc. 

Video Stream: Select the stream for the camera as desired. 

Protocol Type: Select the transmission protocol for the camera. 

Stream Media Server: Configure to get stream of the camera via stream media server. You can 

select and manage the available stream media server. 

Copy to…: Copy the configured parameters to other camera(s). 

Refresh: Get a new captured picture for the live view of the camera. 

Note: For video stream and protocol type, the new settings will take effect after you reopen the 

live view of the camera.  

4. Click OK to save the new settings. 

You can also double-click the group/camera name on the Group Management interface to open 

the Modify Group/Camera dialog box. 

  
 

Removing Channels from the Group 

Steps: 

1. Select the camera from the group list on the Import Encoding Channel page. 

2. Click  to remove the camera from the group. 

You can also select the camera on the Group Management interface, and then click Delete to 

remove the camera from the group. 

Select the group from the group list on the Import Encoding Channel page, click  and you can 

remove all the cameras from the group. 

 

Deleting the Group 

Steps: 
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1. Select the group on the Group Management interface 

2. Click Delete Group or click the icon , the selected group and the resource under it will be 

deleted. 

2.4 Basic Operations in Live View 

Purpose: 

For the surveillance task, you can view the live video of the added network cameras and video 

encoders on the Main View page. And some basic operations are supported, including picture 

capturing, manual recording, PTZ control, etc. 

Before you start: 

A camera group is required to be defined for live view. 

Click the  icon on the control panel, 

or click View->Main View to open the Main View page. 

 

 

Main View Page 

1 View List 

2 Camera List 

3 PTZ Control Panel 

4 Display Window of Live View 

5 Live View Toolbar 

 

Camera Status: 

 The camera is online and works properly. 

 The camera is in live view. 

 The camera is in recording status. 

 The camera is offline. 

 

Live View Toolbar: 
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On the Main View page, the following toolbar buttons are available: 

 Set Screen Layout Set the screen layout mode. 

 Save View Save the new settings for the current view. 

 Save View as Save the current view as another new view. 

 Stop Live View Stop the live view of all cameras. 

 Previous Go for live view of the previous page. 

 Next Go for live view of the next page. 

  
Resume/Pause 

Auto-switch 
Click to resume/pause the auto-switch in live view. 

 Show /Hide the Menu Show/Hide the menu of auto-switch. Click again to hide. 

  Mute/Audio On Turn off/on the audio in live view 

 Full Screen Display the live view in full screen mode. Press ESC to exit. 

 

Right-click on the display window in live view to open the Live View Management Menu: 

 

 

The following buttons are available on the right-click Live View Management Menu: 

 Stop Live View Stop the live view in the display window. 

 Capture Capture the picture in the live view process. 

 Print Captured Picture Capture the current picture and then print the picture. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

 Start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC. 

 Open PTZ Control 
Enable PTZ control function on the display window. Click again to 

disable the function. 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 
Switch to Instant 

Playback 
Switch to instant playback mode.  

  
Start/Stop Two-way 

Audio 
Click to start/stop the two-way audio of the camera in live view. 

  Enable/Disable Audio Click to enable/disable the audio in live view. 

 Camera Status Display the status of the camera in live view, including the recording 
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status, signal status, connection number, etc. 

 Remote Config Open the remote configuration page of the camera in live view. 

 VCA Config 
Enter the VCA configuration interface of the device if it is VCA 

device. 

 Synchronization Sync the camera in live view with the PC running the client software. 

 Full Screen Display the live view in full screen mode. Click the icon again to exit. 

   

   

 

2.4.1 Starting and Stopping the Live View 

Starting Live View for One Camera 

Steps: 

1. Open the Main View page. 

2. Optionally, click the  icon in live view toolbar to select the screen layout mode for live view. 

3. Click-and-drag the camera to the display window, 

or double-click the camera name after selecting the display window to start the live view. 

Note: You can click-and-drag the video of the camera in live view to another display window if 

needed. 

Starting Live View for Camera Group 

Steps: 

1. Open the Main View page. 

2. Click-and-drag the group to the display window, 

or double-click the group name to start the live view. 

Note: The display window number is self-adaptive to the camera number of the group. 

Starting Live View in Default View Mode 

Purpose: 

The video of the added cameras can be displayed in different view modes. 4 frequently-used default 

view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the default view list. 

3. Click to select the default view mode and the video of the added cameras will be displayed in a 

sequence in the selected view. 

Note: Right-click the current default view name on the list and click Save View As. or click , and 

you can save the default view as a custom view. 

Starting Live View in Custom View Mode 

Purpose: 



PC Client User Manual  

17 
 

The view mode can also be customized for the video live view. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the custom view list. 

3. Click New View in the custom view list to create a new view. 

4. Input the view name and click Add. The new view is of 4-Screen mode by default. 

5. Optionally, click the  icon in live view toolbar and select the screen layout mode for the new 

view. 

6. Click-and-drag the camera/group to the display window, 

or double-click the camera/group name in custom view mode to start the live view. 

7. Click the icon  to save the new view. 

 

Right-click the custom view name on the list, and a menu pops up as follows: 

 

 

The following buttons are available on the right-click menu: 

 Edit View Name Edit the name of the custom view. 

 Delete View Delete the custom view. 

 Save View Save the new settings of the custom view. 

 Save View As. Save the current view as another custom view. 

 

Stopping the Live View 

Steps: 

1. Select the display window. 

2. Click the icon  that appears in the upper-right corner when the mouse pointer is over the 

display window, 

or click Stop Live View on the right-click menu to stop the live view of the display window. 

You can also click the button  in live view toolbar to stop all the live view. 

2.4.2 Auto-switch in Live View 

Camera Auto-switch 

Purpose: 

The video stream of the cameras from the same group will switch automatically in a selected display 

window in camera auto-switch.  

Steps: 

1. Open the Main View page. 

2. Select a display window for camera auto-switch. 

3. Click the icon  in the toolbar and select or customize the switching interval. 
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4. Select a group and click the icon  on the group node. 

5. You can click the icon /  to pause/resume the camera auto-switch. 

Single View Auto-switch 

Purpose: 

The video of all the cameras on the camera list will switch automatically in a selected default view in 

single view auto-switch. 

Steps: 

1. Open the Main View page. 

2. Click the icon  in the toolbar and select or customize the switching interval. 

3. Select a default view and click the icon  on the selected view node. 

4. You can click the icon /  to pause/resume the single view auto-switch. 

Multi-view Auto-switch 

Purpose: 

The custom views will switch automatically in multi-view auto-switch. The custom views need to be 

added before proceeding. 

Steps: 

1. Open the Main View page. 

2. Click the icon  in the toolbar and select the switching interval. 

3. Click the icon  on the custom view node. 

4. You can click the icon /  to pause/resume the multi-view auto-switch. 

2.4.3 PTZ Control in Live View  

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset, 

patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ 

control for the operations of PTZ cameras. 

Click the icon  to expand the PTZ Control panel. 

 
 

The following buttons are available on the PTZ Control panel: 

 Zoom 

 Focus 
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 Iris 

 Auxiliary Focus 

 3D Positioning 

 Light 

 Wiper 

 Lens Initialization 

 

Configuring the Preset 

A preset is a predefined image position which contains information of pan, tilt, focus and other 

parameters. 

Perform the following steps to add a preset: 

1. Click the Preset button to enter the PTZ preset configuration panel. 

2. Click the direction buttons and other buttons on the PTZ control panel to steer the camera to the 

desired view. 

3. Select a PTZ preset number from the preset list and click . 

4. Input the name of the preset in the pop-up dialog box. 

5. Click OK to save the settings. 

 

To call a configured preset, double-click the preset, or select the preset and click the icon . 

To modify a configured preset, select the preset from the list and click the icon . 

To delete a configured preset, select the preset from the list and click the icon . 

  
 

Configuring the Pattern 

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions. 

Perform the following steps to add a pattern: 

1. Click the Pattern button to enter the PTZ pattern configuration panel. 

2. Click  to start recording of this pattern path. 

3. Use the direction buttons to control the PTZ movement. 

4. Click  to stop and save the pattern recording.  

5. Click the icon  to call the pattern. To stop calling the pattern, click . 
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Configuring the Patrol 

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable. 

Before you start: 

Two or more presets for one PTZ camera need to be added. 

Perform the following steps to add and call a patrol: 

1. Click the Patrol button to enter the PTZ patrol configuration panel. 

2. Select a track number from the drop-down list. 

3. Click  to add a preset, and set the dwell time and patrol speed for the preset. 

4. Repeat the above operation to add other presets to the patrol. 

5. Optionally, you can click  or  to edit or delete a preset in the patrol path. 

6. Click the icon  to call the patrol. To stop calling the patrol, click . 

Notes: 

 Up to 16 patrols can be configured. 

 The preset dwell time can be set to 1~30 sec, and the patrol speed can be set to level 1~40. 

  

2.4.4 Manual Recording and Capture 

Toolbar in Each Live View Display Window: 
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In each live view display window, the following toolbar buttons are available: 

 Capture 
Capture the picture in the live view process. The capture picture 

is stored in the PC. 

  Start/Stop Recording Start/Stop manual recording. The record file is stored in the PC. 

 
Switch to Instant 

Playback 
Switch to the instant playback mode. 

 

Manual Recording in Live View 

Purpose: 

Manual Recording function allows you to record the live video on the Main View page manually and 

the record files are stored in the local PC. 

Steps: 

1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click  in the toolbar of the display window or on the right-click Live View Management Menu 

to start the manual recording. The icon  turns to . 

3. Click the icon  to stop the manual recording. 

A prompt box with the saving path of the video files you just recorded will pop up if all the 

operations succeed. 

Notes:  

 During the manual recording, an indicator  appears in the upper-right corner of the display 

window. 

 The saving path of video files can be set on the System Configuration interface. For details, see 

Section 7.2.2 File Saving Path Settings. 

Viewing Local Record Files  

Steps: 

1. Click File->Open Video File to open the Record Files page. 

2. Select the camera to be searched from the Camera Group list. 

3. Click the icon  to specify the start time and end time for the search. 

4. Click Search. The video files recorded between the start time and end time will be displayed. 

Select the video file, and click Delete. You can delete the video file. 

Select the video file, and click Email Linkage. You can send an Email notification with the selected 

video file attached. 

Select the video file, and click Save as. You can save a new copy of the video file. 

Note: To send an Email notification, the Email settings need to be configured before proceeding. For 

details, see Section 7.2.4 Email Settings. 
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Double-click the video file and the video file can be played back locally. 

 

 

The following buttons are available on the local playback page: 

  CIF/4CIF Display the video in cif/4cif resolution. 

 Full Screen Display the local playback page in full screen mode. 

 Close Close the local playback page of the record files. 

  Pause/Play Pause/Start the playback of the record files. 

 Stop Stop the playback of the record files. 

 Speed Set the playback speed.  

 Single Frame Play back the record files frame by frame. 

 Digital Zoom Enable the digital zoom function. Click again to disable. 

  Enable/Disable Audio Click to enable/disable the audio in the local playback. 

 Capture Capture the picture in the playback process. 

 

Capturing Picture in Live View 
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Steps: 

1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click the icon  in the toolbar of the display window or on the right-click Live View 

Management Menu. 

A small window of the captured picture will be displayed to notify whether the capturing 

operation is done or not.  

Note: The saving path of the captured pictures can be set on the System Configuration interface. For 

details, see Section 7.2.2 File Saving Path Settings. 

Viewing Captured Pictures 

The pictures captured in live view are stored in the PC running the software. You can view the 

captured pictures if needed. 

Steps: 

1. Click File->Open Captured Picture to open the Captured Picture page. 

2. Select the camera to be searched from the Camera Group list. 

3. Click the icon  to specify the start time and end time for the search. 

4. Click Search. The pictures captured between the start time and end time will be displayed. 

5. Double-click the captured picture to enlarge it for a better view. 

Select the captured picture, and click Print. You can print the selected picture. 

Select the captured picture, and click Delete. You can delete the selected picture. 

Select the captured picture, and click Email Linkage. You can send an Email notification with the 

selected picture attached. 

Select the captured picture, and click Save as. You can save a new copy of the selected picture. 

 

 

2.4.5 Instant Playback 

Purpose: 

The record files can be played back instantly on the Main View page. Instant playback shows a passage 

of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an 

immediate review if needed. 
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Before you start: 

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on 

the DVRs, NVRs, Network Cameras, etc., or on the storage servers. 

Steps: 

1. Start the live view and move the mouse pointer to the display window to show the toolbar. 

2. Click the icon  in the toolbar and a list of time periods pops up.  

30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable. 

3. Select a time period to start the instant playback. 

Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant 

playback will start from 09:27:00. 

4. Click the icon  again to stop the instant playback and go back for the live view. 

Notes:  

 During the instant playback, an indicator  appears in the upper-right corner of the display 

window. 

 The live view process will continue after the instant playback completed. 

 

 

Right-click on the display window to open the Instant Playback Management Menu: 

 

 

The following buttons are available on the right-click Instant Playback Management Menu: 
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  Pause/Play Pause/Start the instant playback in the display window. 

 Stop Stop the instant playback and return to the live view mode. 

  Speed Up/Down Increase/Decrease the play speed of the instant playback. 

 Single Frame Play back the record file frame by frame. 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 Capture Capture the picture in the instant playback process. 

 Print Captured Picture Capture the current picture and then print the picture. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

  Start/Stop Recording Start/Stop clipping the record files. 

  Enable/Disable Audio Click to turn on/off the audio in instant playback. 

 Switch to Live View Switch to live view mode.  

 Full Screen Display the instant playback in full screen mode. Click again to exit. 

 

2.4.6 Other Functions in Live View 

There are some other functions supported in the live view, including digital zoom, two-way audio, 

camera status and synchronization. 

Auxiliary Screen Preview 

The live video can be displayed on different auxiliary screens for the convenient preview of multiple 

monitoring scenes. Up to 3 auxiliary screens are supported. 

Digital Zoom 

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the 

rectangle area will zoom in/out. 

Two-way Audio 

Two-way audio function enables the voice talk of the camera. You can get not only the live video but 

also the real-time audio from the camera. This two-way audio can be used for only one camera at one 

time. 

Camera Status 

The camera status, such as recording status, signal status, connection number, etc., can be detected 

and displayed for check. The status information refreshes every 10 seconds.  

Synchronization 

The synchronization function provides a way to synchronize the device clock with the PC which runs 

the client software. You can also synchronize the clock of multiple devices with the PC which runs the 

client software in batch. 
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Chapter 3  Remote Record Schedule 

Settings and Playback 

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the 

remote storage server connected, you can set the record schedule for the cameras for the continuous, 

alarm triggered or command triggered recording. And the record files can be searched for the remote 

playback. 

3.1 Remote Recording 

Purpose: 

The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the 

storage server connected. 

Click the  icon on the control panel, 

or click Tool->Record Schedule to open the Record Schedule page. 

 

 

3.1.1 Recording on Storage Devices on the NVRs, or 

Network Cameras 

Purpose: 

NVRs and Cameras (IP Mini Dome), provide storage devices such as the HDDs and SD cards for record 

files. You can set a record schedule or capture schedule for the channels of the local devices. 

Notes: The pictures captured through the capture schedule are stored on the local device and can be 

searched on the remote configuration page of the device. 

Before you start: 
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The newly installed storage devices need to be formatted. Go to the remote configuration page of the 

device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the 

selected storage device. 

Steps: 

1. Open the Record Schedule page. 

2. Select the camera in the Camera Group list. 

3. Check the checkbox Record Schedule / Capture Schedule under Local Recording to enable device 

local recording or capture. 

4. Select the record schedule template from the drop-down list. 

All-day Template: for all-day continuous recording. 

Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM. 

Event Template: for the event triggered recording. 

Template 01-08: fixed templates for specific schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, see Configuring Record Schedule Template. 

5. Click Advanced Settings to set the recording parameters. For details, see Table 3.1 Advanced 

Recording Settings and Table 3.2 Advanced Capture Settings. 

6. Optionally, click Copy to… to copy the record schedule settings to other channels. 

7. Click Save to save the settings. 

  

 

Table 3.1 Advanced Recording Settings 

Parameters Descriptions 

Pre-record 
Normally used for the event triggered record, when you want to record before 

the event happens 

Post-record After the event finished, the video can also be recorded for a certain time. 

Video Expired Time 
The time for keeping the record files in the storage device, once exceeded, the 

files will be deleted. The files will be saved permanently if the value is set as 0. 

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD. 

Record Audio Record the video files with audio or not. 
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Video Stream Select the stream type for the recording. 

Table 3.2 Advanced Capture Settings 

Parameters Descriptions 

Resolution Select the resolution for the continuous or event captured pictures. 

Picture Quality Set the quality for the continuous or event captured pictures. 

Interval 
Select the interval which refers to the time period between two capturing 

actions. 

 

 

Configuring Record Schedule Template 

Perform the following steps to configure the record schedule template: 

If Template 01-08 is selected from the drop-down list, start from step 1; 

If Custom is selected from the drop-down list, start from step 2. 

1. Click Edit to enter the Templates Management interface. Select the template to be set and you 

can edit the template name. 

2. Set the time schedule for the selected template. 

 refers to normal schedule record. The schedule time bar is marked with . 

 refers to the schedule record for the event. The schedule time bar is marked 

with . 

 refers to the schedule record triggered by command. The schedule time bar is 

marked with . 

Note: Record triggered by command is only available for the ATM transactions when the ATM DVR 

is added to the PC Client. 

When the cursor turns to , you can edit the schedule time bar. 

When the cursor turns to , you can move the selected time bar you just edited. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click OK to save the settings.  

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom 

template can be saved as template 01--08. 

Note: Up to 8 time periods can be set for each day in the record schedule. 
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3.2 Remote Playback 

Purpose: 

The record files stored on the local device or the storage server can be searched by custom view, 

camera or triggering event, and then can be played back remotely. 

Click the  icon on the control panel, 

or click View->Remote Playback to open the Remote Playback page. 
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Remote Playback Page 

1 View List, Camera List and Event List 

2 Calendar 

3 Search Options 

4 Search Result List 

5 Display Window of Playback 

6 Playback Toolbar 

7 Timeline 

3.2.1 Normal Playback 

Purpose: 

The record files can be searched by custom view, camera or triggering event for the Normal Playback. 

Searching Record Files for Normal Playback 

Steps: 

1. Open the Remote Playback page. 

2. Click  to expand the View List or Camera List on the left-side. 

3. Select the view or camera to be searched from the list. 

4. Select the day to be searched on the calendar. 

You can also click  to show more search options, and then click the icon  to specify the 

start time and end time for the search. 

5. Click Search. The record files of the selected view or camera will be displayed on the Search 

Result list. You can filter the results through the Filter text field. 

Notes:  

 You can also search the record files by the ATM query (only applicable to ATM DVR) or by the file 

type. 

 Up to 16 cameras can be searched simultaneously. 
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Playing Back Record Files 

After searching the record files for the normal playback, you can play back the record files in the 

following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  on the record file, 

or double-click the record file to play the video on the display window of playback. 

You can also select a display window and click the icon  in the toolbar to play back the 

corresponding record file. 

 Playback by Timeline 

The timeline indicates the time duration for the record file, and the record files of different types 

are color coded. Click on the timeline to play back the video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can click  or  to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

 

 

Normal Playback Toolbar: 

 
On the Normal Playback page, the following toolbar buttons are available: 

 Playback Speed Set the playback speed for the selected display window. 

  Async/Sync Click to play back the record files 
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Playback synchronously/asynchronously. 

 Stop Playback Stop the playback of all cameras. 

  
Pause/Start 

Playback 
Pause/Start the playback of the record files. 

 Single Frame Play back the record files frame by frame. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen 
Display the video playback in full screen mode. Press ESC to 

exit. 

 

Right-click on the display window in playback to open the Playback Management Menu: 

 
The following items are available on the right-click Playback Management Menu: 

 Reverse Playback Play back the record file reversely. 

  Pause/Start Pause/Start the playback. 

 Stop Stop the playback. 

 Speed Up Play back the record file at a faster speed. 

 Speed Down Play back the record file at a slower speed. 

 Single Frame Play back the record file frame by frame. 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 Tag Control 

Add default (default tag name TAG) or custom tag (customized tag 

name) for the video file to mark the important video point. You can 

also edit the tag or go to the tag position conveniently. 

 Accurate Positioning Set the accurate time point to play back the record file. 

 Capture Capture the picture in the playback process. 

 Print Captured Picture Capture a picture and print it. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

 Start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC. 

 Download 
Download the record files of the camera and the record files are 

stored in the PC. You can select to download by file or by date. 

  Enable/Disable Audio Click to enable/disable the audio in playback. 

 Full Screen Display the playback in full-screen mode. Click the icon again to exit. 
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3.2.2 Event Playback 

Purpose: 

The recordings triggered by event, such as motion detection, video loss or alarm input, can be 

searched for Event Playback and this function requires the support of the connected device. 

Searching Record Files for Event Playback 

Steps: 

1. Open the Remote Playback page. 

2. Click  to expand the Event List on the left-side. 

3. Select the event type from the drop-down list, and select the cameras or alarm input sensors. 

4. Select the day to be searched on the calendar. 

You can also click  to show more search options, and then click the icon  to specify the 

start time and end time for the search. 

5. Click Search. The recordings from the selected cameras and sensors triggered by event will be 

displayed on the Search Result list.  

Playing Back Record Files 

After searching the recordings triggered by the event, you can play back the record files in the 

following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  on the record file, 

or double-click the record file to play the video on the display window of playback. 

You can also select a display window and click the icon  in the toolbar to play back the 

corresponding record file. 

 Playback by Timeline 

The timeline indicates the time duration for the record file. Click on the timeline to play back the 

video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can click  or  to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

Event Playback Toolbar: 

 

On the Remote Playback page, the following toolbar buttons are available: 

 Playback Speed Set the playback speed for the selected display window. 

 Stop Playback Stop the playback of all channels. 

  
Pause/Start 

Playback 
Pause/Start the playback of record files. 

 Single Frame Play back the record files frame by frame. 

 Previous Event Go to the playback of the previous event. 

 Next Event Go to the playback of the next event. 
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  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen Display the video playback in full screen mode. Press ESC to exit. 

 

3.2.3 Synchronous Playback 

Purpose: 

In synchronous playback, the record files can be played back in synchronization. 

Note: Record files from up to 16 cameras can be played back simultaneously. 

 

Steps: 

1. Search the record files for the normal playback.  

2. Click  in the toolbar to enable the synchronous playback. The icon  turns to . 

3. Select the record file from the list and click , 

or click on the timeline to start the synchronous playback for all searched cameras. 

4. To disable the synchronous playback, click the icon . 

 
 

 

3.2.4 VCA Playback 

Purpose: 

You can set VCA rule to the searched record files and find the video that VCA event occurs, including 

VCA Search, Intrusion and Line Crossing. This function helps to search out the video that you may be 

more concerned, mark it with red color and the playback speed of the concerned video and 

unconcerned video can be customized. 

 VCA Search: Get all the related motion detection events that occurred in the pre-defined region. 

 Intrusion: Detect whether there are people, vehicles and other moving objects intruding into the 

pre-defined region. 
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 Line Crossing: Bi-directionally detect people, vehicles and other moving objects that cross a 

virtual line. 

Steps: 

1. Search the record files for the normal playback and play back the record file(s). 

2. Select a playback window and click  to expand the VCA Playback panel. 

3. Select the VCA Type, draw the detection region and set the sensitivity. 

Notes:  

 For VCA Search, click , and then click and move on the playback window to set the grid 

rectangle as the detection region. Or you can click  to set all the area shot by the 

camera as the detection region. 

 For Intrusion, click  and then click on the playback window to set the vertex for the 

detection region. 

 For Line Crossing, click  and then click on the playback window to set the beginning 

point in the area and move the mouse and click again to set the end of the line. 

 To delete the drawn region, click  to remove it. 

4. Optionally, click  to expand the More Search Options panel. You can configure the advanced 

settings for the VCA Search. 

 Skip Unconcerned Video: Check the checkbox and the video that no VCA event occurs will 

be skipped during playback. 

 Speed of Unconcerned Video: Set the playback speed for the unconcerned video as 

desired. 

 Speed of Concerned Video: Set the playback speed for the concerned video as desired. 

 Pre-play: Set the time to play back before the VCA event. For example, when a VCA event 

occurs at 10:00, if you set the pre-play time as 5 seconds, the video plays back from 9:59:55. 

 Post-play: Set the time to play back after the VCA event. For example, when a VCA event 

ends at 11:00, if you set the post-play time as 5 seconds, the video plays back till 11:00:05. 

5. Click Search and the VCA events occurred in the defined area will be red marked on the timeline. 
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Chapter 4  Event Management 

Purpose: 

In the PC Client software, rules can be set up for triggers and linkage actions. You can assign linkage 

actions to the trigger by setting up a rule. For example, when motion is detected, an audible warning 

appears or other linkage actions happen. 

Click the  icon on the control panel, 

or click Tool->Event Management to open the Event Management page. 

 

 

You can set different linkage actions for the following triggers: 

Note: The event detection should be supported by the device before you can configure it. 

 Motion Detection 

 Video Tampering Alarm 

 Video Loss 

 Device Exception 

4.1 Configuring Motion Detection Alarm 

Purpose: 

A motion detection alarm is triggered when the client software detects motion within its defined area. 

The linkage actions, including alarm output, channel record and client action can be set. 

Note: The configuration varies according to different devices. For details, please refer to the User 

Manual of the devices. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Motion Detection as the event type. 
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3. Check the checkbox Enable to enable the function of motion detection. Check the checkbox 

Enable Motion Dynamic Analysis to mark the detected objects with green rectangles in live 

view and playback. 

4. Select the arming schedule template from the drop-down list. 

All-day Template: for all-day continuous arming. 

Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM. 

Template 01-09: fixed templates for special schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Click-and-drag the mouse to draw a defined area for the arming region. 

You can click the icon  to set the whole video area as detection area, or click the icon  to 

clear all the detection area. 

6. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the 

value is, the more sensitive the detection is. 

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.1 Linkage Actions for 

Motion Detection Alarm. 

8. Optionally, click Copy to… to copy the event parameters to other channels. 

9. Click Save to save the settings.  

 

 

Table 4. 1 Linkage Actions for Motion Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image with alarm information pops up when alarm is triggered. 

Alarm Triggered Display the video on the Video Wall when alarm is triggered. 
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Video Wall Display Note: This option is only available when the decoding device is added. 

 

Configuring Arming Schedule Template 

Perform the following steps to configure the arming schedule template: 

If Template 01-09 is selected in the drop-down list, start from step 1; 

If Custom is selected in the drop-down list, start from step 2. 

Steps: 

1. Click Edit to enter the Templates Management interface. Select the template to be set and you 

can edit the template name. 

2. Set the time schedule for the selected template. 

When the cursor turns to , you can edit the schedule time bar. 

When the cursor turns to , you can move the selected time bar you just edited. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click OK to save the settings. 

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom 

template can be saved as template 01--09. 

Note: Up to 4 time periods can be set for each day in the arming schedule template. 
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4.2 Configuring Video Tampering Alarm 

Purpose: 

A video tampering alarm is triggered when the camera is covered and the monitoring area cannot be 

viewed. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Open the Event Management page and click the Camera Event tab. 

2. Select the camera to be configured and select Tampering Alarm as the event type. 

3. Check the checkbox Enable to enable the function of video tampering. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Select the triggered camera. The image or video from the triggered camera will pop up or be 

displayed on the Video Wall when tampering alarm occurs. 

6. Click-and-drag the mouse to draw a defined area for the arming region.  

You can click the icon  to set the whole video area as detection area, or click the icon  to 

clear the detection area.  

7. Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.  

8. Check the checkboxes to activate the linkage actions. For details, see Table 4.2 Linkage Actions for 

Tampering Alarm. 

9. Optionally, click Copy to… to copy the event parameters to other cameras. 

10. Click Save to save the settings. 
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Table 4. 2 Linkage Actions for Tampering Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 
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4.3 Configuring Video Loss Alarm 

Purpose: 

When the client software cannot receive video signal from the front-end devices, the video loss alarm 

will be triggered. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Video Loss as the event type. 

3. Check the checkbox Enable to enable the function of video loss alarm. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Select the triggered camera. The image or video from the triggered camera will pop up or be 

displayed on the Video Wall when video loss alarm occurs. 

6. Check the checkboxes to activate the linkage actions. For details, see Table 4.4 Linkage Actions for 

Video Loss Alarm. 

7. Optionally, click Copy to… to copy the event parameters to other cameras. 

8. Click Save to save the new settings. 

 
 

Table 4. 3 Linkage Actions for Video Loss Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 
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4.4 Configuring Device Exception Linkage 

Steps: 

1. Open the Event Management page and click the Device Exception tab. 

2. Select the device to be configured. 

3. Select the device exception type, including HDD full, HDD exception, illegal login, etc. 

4. Check the checkbox Enable. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.13 Linkage Actions 

for Device Exception. 

6. Optionally, click Copy to… to copy the event parameters to other devices. 

7. Click Save to save the settings. 

 

Table 4. 4 Linkage Actions for Device Exception 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  
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4.5 Viewing Alarm and Event Information  

The information of recent alarms and events can be displayed. Click the icon  in Alarms and Events 

Toolbar on the bottom of the screen to show the Alarms and Events panel.  

 

 

Or click  to display the Alarm Event interface. 

 
 

On the Alarms and Events panel, the following toolbar buttons are available: 

 Clear Info Clear the information of alarms and events displayed on the list. 

  
Enable/Disable Alarm 

Triggered Pop-up Image 
Click to enable/disable image pop-up when alarms occur. 

  Enable/Disable Audio Click to enable/disable the audio warning for the alarm. 

  Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel. 

 Maximize Maximize the Alarms and Events panel in a new tab page. 

  Show/Hide Click to show/hide the Alarms and Events panel. 

 

Viewing Alarms Information 

Different alarm types can be displayed on the panel: Motion Detection, Video/Audio Exception, Alarm 

Input, Device Exception, VCA Alarm and Other Alarm. You can check the checkbox to enable the 

displaying of that type alarm. 

Before you start: 

To display the alarms, the event parameters need to be configured. 

Steps: 

1. Click the Alarm tab. 

2. Check the checkboxes of different alarm types. 
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3. When an alarm occurs, the icon  twinkles to call attention. The alarm information, including 

the time, source, details and content will be displayed.  

Click  to get a live view of the alarm triggered camera. 

Click  to send an Email notification of the alarm to one or more receivers. 

Click  to display the video of alarm triggered camera on the Video Wall. You can enter the 

Video Wall interface to check the alarm triggered video playing on the screen which set as the 

alarm window. The physical video wall also display the video. 

Note: You should add decoding device and configure the video wall. For details, please refer to 

Error! Reference source not found.Error! Reference source not found.. 

Click under the Note column to input the description for the alarm. 

4. To clear the alarm information, click the icon , or right-click on an alarm log and then click 

Clear. 

Viewing Events Information 

Purpose: 

The abnormal events of the client software, such as the live view failure, device disconnection, can 

also be displayed. 

Steps: 

1. Click the Event tab.  

The event information, including the time and detailed description will be displayed. 

2. To clear the event information, click the icon , or right-click on the event log and then click 

Clear. 
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Chapter 5  E-map Management 

Purpose: 

The E-map function gives a visual overview of the locations and distributions of the installed cameras 

and alarm input devices. You can get the live view of the cameras on the map, and you will get a 

notification message from the map when alarm is triggered. 

Click the  icon on the control panel, 

or click View->E-map to open the E-map page. 

 

 

E-map Page 

1 Group List 

2 Map Display Area 

3 E-map Toolbar 

5.1 Adding an E-map 

Purpose: 

An E-map needs to be added as the parent map for the hot spots and hot regions. 

Steps: 

1. Open the E-map page. 

2. Select a group for which you want to add a map. 

3. Click the icon  in the Map Display Area to open the map adding dialog box. 

4. Input a descriptive name of the added map as desired. 

5. Click the icon  and select a map file from the local path.  

6. Click OK to save the settings. 

Notes:  
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 The picture format of the map can only be *.png, *.jpg or *.bmp. 

 Only one map can be added to a group. 

 
 

The map added is displayed in the Map Display Area. Use the mouse wheel or click  or , to 

zoom in or zoom out on the map. You can click-and-drag the yellow window in the lower-right corner 

or use the direction buttons and zoom bar to adjust the map area for view. 

 

 

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or 

map preview mode. 

E-map Toolbar in Map Editing Mode: 

 
E-map Toolbar in Map Preview Mode: 

 
 

On the E-map page, the following toolbar buttons are available: 

 Modify Map Modify the map information, including the map name and file path. 

 Delete Map Delete the current map. 

 Add Camera Add a camera as the hot spot on the map. 

 Add Alarm Input Add an alarm input sensor as the hot spot on the map. 

 Add Hot Region Add a map as the hot region on the current map. 

 Modify Modify the information of the selected hot spot or hot region. 



PC Client User Manual  

47 
 

 Delete Delete the selected hot spot or hot region. 

 Clear Alarm Info Clear the alarm information displayed on the map. 

 
Back to Parent 

Map 
Go back to the parent map. 

 

5.2 The Hot Spot Function 

Purpose: 

The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots 

show the locations of the cameras and alarm inputs, and you can also get the live view and alarm 

information of the surveillance scenarios through the hot spots. 

5.2.1 Adding Hot Spots 

Adding Cameras as Hot Spots 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the cameras to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon. 

5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons 

of added cameras changes from  to  in the group list. You can click-and-drag the camera 

icons to move the hot spots to the desired locations. 

You can also click-and-drag the camera icons from the group list to the map directly to add the 

hot spots. 

 

 

Adding Alarm Inputs as Hot Spots 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 
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2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the alarm inputs to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon. 

5. Click OK to save the settings. The alarm input icons are added on the map as hot spots and the 

icons of added alarm inputs changes from  to   in the group list. You can click-and-drag 

the alarm input icons to move the hot spots to the desired locations. 

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to 

add the hot spot. 

 

5.2.2 Modifying Hot Spots 

Purpose: 

You can modify the information of the added hot spots on the map, including the name, the color, the 

icon, etc. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select the hot spot icon on the map and then click  in the toolbar, right-click the hot 

spot icon and select Modify, or double-click the hot spot icon on the map to open the Modify Hot 

Spot dialog box. 

3. You can edit the hot spot name in the text field and select the color, the icon and the linked 

camera or alarm input. 

4. Click OK to save the new settings. 

To delete the hot spot, select the hot spot icon and click  in the toolbar, or right-click the hot 

spot icon and select Delete. 
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5.2.3 Previewing Hot Spots 

Steps: 

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode. 

2. Double-click the camera hot spots, and you can get the live view of the cameras.  

3. If there is any alarm triggered, an icon  will appear and twinkle near the hot spot. Click the 

alarm icon, and then you can check the alarm information, including alarm type and triggering 

time. 

Note: To display the alarm information on the map, the Alarm on E-map functionality needs to be 

set as the alarm linkage action. For details, refer to 0  



PC Client User Manual  

50 
 

Event Management. 

 

 

5.3 The Hot Region Function 

Purpose: 

The hot region function links a map to another map. When you add a map to another map as a hot 

region, an icon of the link to the added map is shown on the main map. The added map is called child 

map while the map to which you add the hot region is the parent map. 

Note: A map can only be added as the hot region for one time. 

5.3.1 Adding Hot Regions 

Before you start: 

Add another map to the group. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select an added map as the parent map. 

3. Click the icon  in the toolbar to open the Add Hot Region dialog box. 

4. Check the checkbox to select the child map to be linked. 

5. Optionally, you can edit the hot region name, and select the hot region color and icon. 

6. Click OK to save the settings. The child map icons are added on the parent map as the hot regions. 

You can click-and-drag the child map icons to move the hot regions to the desired locations. 
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5.3.2 Modifying Hot Regions 

Purpose: 

You can modify the information of the hot regions on the parent map, including the name, the color, 

the icon, etc. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select the hot region icon on the parent map and then click  in the toolbar, right-click the hot 

spot icon and select Modify, or double-click the hot region icon to open the Modify Hot Region 

dialog box.  

3. You can edit the hot region name in the text field and select the color, the icon and the linked 

child map. 

4. Click OK to save the new settings. 

To delete the hot region, select the hot region icon and click  in the toolbar, or right-click the 

hot spot icon and select Delete. 
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5.3.3 Previewing Hot Regions 

Steps: 

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode. 

2. Click the hot region icon to go to the linked child map. 

3. The hot spots can also be added on the hot regions. 

4. You can click the icon  in the toolbar to go back to the parent map.  

You can also click the icon  in the toolbar to clear the alarm information. 
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Chapter 6  Log Management 

Purpose: 

The log files of the client software are stored on the local PC and can be searched for checking. 2 types 

of log files are provided: client logs and server logs. The client logs refer to the log files of the client 

and are stored on the local PC; the server logs refer to the log files of the connected devices and are 

stored on the local device. 

Click the  icon on the control panel to open the Log Search page. 

 

Searching Log Files 

Steps: 

1. Open the Log Search page. 

2. Select the log type. If Server Logs is selected, then click to specify the device for search. 

3. Click the icon  to specify the start time and end time. 

4. Click Search. The log files between the start time and end time will be displayed on the list. 

You can check the operation time, description and other information of the logs. 

Note: Please narrow the time range or filter the log type for search if there are too many log files. 

 
 



PC Client User Manual  

54 
 

Filtering Log Files 

Purpose: 

After searched out successfully, the log files can be filtered by the keyword or condition, and thus you 

can find the logs as you want. 

Steps: 

1. Click Log Filter or the icon  on the Log Search page to expand the Log Filter panel. 

2. Select Filter by Keyword, and then input keyword for filtering in the text field; or 

select Filter by Condition, and then specify log type in the drop-down list. 

3. Optionally, you can click More… to filter the log files more accurately. 

4. Click Filter to start filtering. You can click Clear Filter the cancel the filtering. 

 

 

Backing up Log Files 

Purpose: 

The log files, including the client logs and server logs, can be exported for backup. 

Steps: 

1. Set the condition and search the log file. 

2. Click Backup Log to open the Backup Log dialog box. 

3. Click the icon , select a local saving path and set a name for the file. 

4. Click Backup to export the selected log file for backup. 

You can click FileOpen Log File to check the information of the backup log files on local PC. 
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Chapter 7  Account Management and 

System Configuration 

7.1 Account Management 

Purpose: 

Multiple user accounts can be added to the client software, and you are allowed to assign different 

permissions for different users if needed. 

Click the  icon on the control panel, 

or click Tool->Account Management to open the Account Management page. 

 

 

Note: The user account you registered to log into the software is set as the super user. 

Adding the User 

Steps: 

1. Open the Account Management page. 

2. Click Add User to open the Add User dialog box. 

3. Select the user type from the drop-down list. 2 types of user accounts are selectable: 

Administrator: The administrator account has all permissions by default, and can modify the 

passwords and permissions of all operators and its own account. 

Operator: The operator account has no permission by default and you can assign the permissions 

manually. An operator can only modify the password of its own account. 

4. Input the user name, password and confirm password as desired. 

5. Check the checkboxes to assign the permissions for the created user. Optionally, you can select a 

user in the Copy from drop-down list, to copy the permissions of the selected user. 

6. Optionally, you can click Default Permission to restore the default permissions of this user. 
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7. Click Save to save the settings.  

Notes: 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length of the 

password cannot be less than 6 characters. 

 Up to 50 user accounts can be added for the client software. 

 

 

Managing the User 

Purpose: 

After created successfully, the user account is added to the user list on the Account Management page. 

You can edit or delete the information of the user accounts. 

To edit the information of the user, select the user from the list, and click Edit User. 

To delete the information of the user, select the user from the list, and click Delete User. 

For super and administrator user, you can click Copy to to copy the permissions to other user(s). 

Note: The super user cannot be deleted and only the password of the super user can be edited. 

7.2 System Configuration 

Purpose： 

The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email 

settings can be configured. 

Click the  icon on the control panel, 

or click Tool->System Configuration to open the System Configuration page. 



PC Client User Manual  

57 
 

 
 

Note: You can click Default Value to restore the defaults of all the system configurations. 

7.2.1 General Settings 

Purpose: 

The frequently-used parameters, including the log expired time, view scale, etc., can be set. 

Steps: 

1. Open the System Configuration page. 

2. Click the General tab to enter the General Settings interface. 

3. Configure the general parameters. For details, see Table 7.1 General Parameters. 

4. Click Save to save the settings. 

 

 

Table 7.1 General Parameters 
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Parameters Descriptions 

Log Expired Time The time for keeping the log files, once exceeded, the files will be deleted. 

View Scale 
The view scale of the video in live view or playback. It can be set as Full 

Screen, 4:3, 16:9 or Original Resolution. 

Network Performance The current network conditions. It can be set as Normal, Better or Best. 

Play Performance 
The play performance of the live video. It can be set as Shortest Delay or 

Self-adaptive. 

Picture Format Set the file format for the captured pictures during live view or playback. 

Web Server Port 

The server port for accessing PC Client via web browser. By default, it is 80. 

If the port No. of your PC running the PC Client is occupied, you can 

modify it. 

After changing the port No., you should access the client via web browser 

by inputting IP address of the PC running the client : new port No.. Please 

refer to Section Error! Reference source not found. Error! Reference 

source not found. for details. 

Enable Screen Toolbar 

Display 

Show the toolbar on each display window in live view or playback. 

Enable Auto-login Log into the client software automatically. 

Prioritize Playback of 

Record Files on Storage 

Server 

Play back the video files recorded on the storage server preferentially.  

Otherwise, play back the video files recorded on the local device. 

Resume Live View 

Status 

Resume the latest live view status after you log into the client again. 

Auto-change Stream 

Type 

Change the stream type automatically in live view according to the size of 

the display window.  

Highlight for Motion 
Mark the detected objects with green rectangles in live view and 

playback. 

Display Transaction 

Information 

Display the transaction information in the live view. 

VCA Rule Display the VCA rule in the live view. 

Auto Time Adjustment Adjust the time automatically at a specified time point. 

 

7.2.2 File Saving Path Settings 

Purpose: 

The video files from manual recording, the captured pictures and the system configuration files are 

stored on the local PC. The saving paths of these files can be set. 

Steps: 

1. Open the System Configuration page. 

2. Click the File tab to enter the File Saving Path Settings interface. 

3. Click the icon  and select a local path for the files. 

4. Click Save to save the settings. 
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7.2.3 Alarm Sound Settings 

Purpose: 

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client 

can be set to give an audible warning and the sound of the audible warning can be configured. 

Steps: 

1. Open the System Configuration page. 

2. Click the Alarm Sound tab to enter the Alarm Sound Settings interface. 

3. Click the icon  and select the audio files from the local path for different alarms. 

4. Optionally, you can click the icon  for a testing of the audio file. 

5. Click Save to save the settings. 

Note: The format of the audio file can only be *wav. 

 

7.2.4 Email Settings 

Purpose: 

An Email notification can be sent when a system alarm occurs. To send the Email to some specified 

receivers, the settings of the Email need to be configured before proceeding. 

Steps: 



PC Client User Manual  

60 
 

1. Open the System Configuration page. 

2. Click the Email tab to enter the Email Settings interface. 

3. Input the required information. 

Server Authentication (Optional): If your email server requires authentication, check this 

checkbox to use authentication to log into the server and enter the login user name and 

password of your email account. 

SMTP Server: Input the SMTP Server address. 

Port: Input the communication port of Email service. The port is 25 by default. 

User Name: Input the user name of the sender Email address if Server Authentication is checked. 

Password: Input the password of the sender Email address if Server Authentication is checked. 

Sender Address: Input the Email address of the sender. 

Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set. 

4. Optionally, you can check the checkbox Enable SSL to increase the security of email sending. 

5. Optionally, you can click Send Test Email to send an email to the receiver for test. 

6. Click Save to save the settings. 
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Troubleshooting 

Live View 

Problem: 

 Failed to get the live view of a certain device. 

Possible Reasons: 

 Unstable network or the network performance is not good enough. 

 The device is offline. 

 Too many accesses to the remote device cause the load of the device too high. 

 The current user has no permission for live view. 

 The version of the client software is below the needed version. 

Solutions: 

 Check network status and disable other not in use process on your PC. 

 Check the device network status. 

 Restart the device or disable other remote access to the device. 

 Log in with the admin user and try again. 

 Download the client software of the latest version. 

Recording 

Problem: 

 Local recording and remote recording are confused. 

Solutions:  

 The local recording in this manual refers to the recording which stores the record files on the 

HDDs, SD/SDHC cards of the local device. 

 The remote recording refers to the recording action commanded by the client on the remote 

device side. 

Playback 

Problem: 

 Failed to download the record files or the downloading speed is too slow. 

Possible Reasons: 

 Unstable network or the network performance is not good enough. 

 The NIC type is not compatible. 

 Too many accesses to the remote device 

 The current user has no permission for playback. 

 The version of the client software is below the needed version. 

Solutions: 

 Check network status and disable other not in use process on your PC. 

 Directly connect the PC running the client to device to check the compatibility of the NIC card. 

 Restart the device or disable other remote access to the device. 

 Log in with the admin user and try again. 

 Download the client software of the latest version. 
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For further information, including datasheets, FAQ and technical support 

please visit:  

 

www.hills.com.au/videosecurity 

 

http://www.hills.com.au/videosecurity

